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Before you begin

Before you begin

This Learner Guide is based on the unit of competency BSBTEC303 Create electronic
presentations, Release 1. Your trainer or training organisation must give you information
about this unit of competency as part of your training program. You can access the unit
of competency and assessment requirements at:

www.training.gov.au.

How to work through this Learner Guide

This Learner Guide contains a number of features that will assist you in your learning.
Your trainer will advise which parts of the Learner Guide you need to read, and which
Practice Tasks and Learning Checkpoints you need to complete. The features of this
Learner Guide are detailed in the following table.

Feature of the How you can use each feature
Learner Guide

Learning content ~ Read each topic in this Learner Guide. If you come across content that is
confusing, make a note and discuss it with your trainer. Your trainer is in the
best position to offer assistance. It is very important that you take on some
of the responsibility for the learning you will undertake.

Examples These highlight key learning points and provide realistic examples of
workplace situations.

Practice Tasks Practice Tasks give you the opportunity to put your skills and knowledge
into action. Your trainer will tell you which practice tasks to complete.

Summaries Key learning points are provided at the end of each topic.
Learning There is a Learning Checkpoint at the end of each topic. Your trainer will tell
Checkpoints you which Learning Checkpoints to complete. These checkpoints give you

an opportunity to check your progress and apply the skills and knowledge
you have learnt.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Foundation skills

As you complete learning using this guide, you will be developing the foundation skills
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN)
skills and the employability skills required for participation in modern workplaces and

contemporary life.

The following table provides definitions for each foundation skill.

Foundation skill area Foundation skill description

Reading - Evaluates and integrates information and ideas to construct
meaning in an effort to design and create a presentation

Writing - Communicates relationships between ideas and information
in a style appropriate to audience and purpose in
accordance with organisational and task requirements

Planning and organising - Plans and implements routine tasks and workload making
limited decisions on sequencing and timing

Teamwork - Collaborates with others to achieve joint outcomes

viii Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting



What do you already know?

Before you begin

Use the following table to identify what you may already know. This may assist you to

work out what to focus on in your learning,.

Topic Key outcome Rate your confidence
in each section

Topic 1. Prepare to createa 1A

presentation

1B

1C

Topic 2: Create 2A

presentations

2B

2C

2D

2E

Use safe work practices

Determine the purpose, audience
and method of presentation

Identify the task requirements and
use the best application

Follow task and organisational
requirements

Use software functions

Add balance and visual impact

Use features to customise for the
audience

Overcome issues using help
function

U Confident
1 Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
L Not confident

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Topic Key outcome Rate your confidence
in each section

Topic 3: Finalise 3A Proofread your presentation U Confident

presentations U Basic understanding

U Not confident

3B Finalise and print your presentation [ Confident
U Basic understanding
U Not confident

3C Store your presentation U Confident

[ Basic understanding
U Not confident

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting



Topic 1| Prepare to create a presentation

1A Use safe work practices
1B Determine the purpose, audience and method of presentation
1C Identify the task requirements and use the best application

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 A Use safe work practices

Workplace safety is everyone's responsibility.

Both employers and employees must make an active contribution to ensuring their
workplace is safe. Hazards need to be identified and risks assessed to reduce the risk of
injury in the workplace. If you are working at a computer for an extended period of time
each day, your workstation must be comfortable and designed to help you carry out your
tasks efficiently. You will need to organise your work so that you are not doing a repetitive
task for a long time and take regular breaks to stand up and stretch.

Health and safety policies and procedures

Health and safety policies and procedures are documents that ensure all
employees work safely and effectively.

All workplaces in Australia are required to have a health and safety policy in place that
describes the organisation’s and employees’ responsibility for maintaining health and
safety. Workplace policies and procedures reflect the health and safety legislation and its
legal requirements. They outline the specific health and safety requirements that must be
addressed in the organisation.

The policy should include the organisation’s goals and objectives regarding health and
safety to help you fulfil your duty of care as an employee. This means eliminating risks to
health and safety of yourself and your work colleagues wherever possible.

Flexible working arrangements means more employees are working from home offices
or in other remote office locations. Employers still have a responsibility to make sure
that home and remote offices use ergonomic practices and follow health and safety
requirements.

Here is an example of an organisation’s health and safety procedures related to working
in an office and using a computer workstation.
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Health and safety procedures outline:

workstation ergonomics (design and efficiency for work)

standard safety precautions and housekeeping (checking for hazards)

safe handling of hazardous substances, e.g. cleaning products, photocopier toner, etc.
emergency and fire drills

hazard identification and risk control (reducing or eliminating the risk)

manual handling (lifting, pushing, pulling without causing injury)

emergency contact numbers, including local doctors and hospitals

location of first-aid equipment details of first-aid officers.

Standard precautions

Standard precautions include ergonomic practices, workstation design, enforced breaks
and regular exercise routines. A workstation includes a computer, monitor, keyboard,
mouse, desk and chair.

Workers in an office are expected to follow standard precautions when using a
workstation, particularly at a sit-down desk. The repetitive movements and sustained
body positions associated with using a computer can be a hazardous task and place the
worker at risk of developing muscular pain or damage or repetitive strain injuries (RSIs).

Muscular-skeletal disorders arise due to two main factors:

Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through
repeated or continuous use of the same body parts, including static body positions

Sudden damage caused by strenuous activity or unexpected movements, such as when
loads being handled move or change position suddenly

Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and
equipment you use during the day to make sure they are in good working order.

Your organisational policies and procedures should include steps to follow. You may
need to perform this procedure at the start of your work day or at specified intervals
throughout the day.
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Workstation safety procedure/checklist:

(]

Ensure your seat is positioned in front of your computer and that you can reach your
keyboard comfortably.

Position the monitor out of direct sunlight and at the correct height.

Ensure the environment is dust-free.

Ensure cables are secured so no one trips over them.,

Use blinds and window coverings to reduce glare and heat at your workstation.

0O000O

Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60 per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by
applying safe work practices.

Ergonomics is about creating comfortable working conditions by adapting workstations,
tools and equipment to an individual worker’s needs. It also improves performance and
productivity in the workplace. Ergonomics covers all aspects of working, from physical
stresses such as sitting at a workstation all day to environmental factors such as noise,
air conditioning and lighting.

When your posture is poor, you may suffer from aches and pains. Spending a long time
in the same position can put stress on your body and this can be made worse if you are
in an uncomfortable or poorly supported position. These symptoms may be very slight at
first, but if you continue to have poor posture your symptoms may get worse and become
intolerable. They may result in cumulative stress given the constant strain on your
muscles, nerves or tendons.

When setting up your workstation, make sure your posture will not cause you pain or
discomfort. The equipment you use needs to be adjusted to suit your body shape and
size, and the tasks you are doing,.

Ergonomic workstation design

How your workstation is designed can affect your health and wellbeing.

Several physical problems can result from poor workstation design; for example, lower
back strain may result from sitting in a chair that does not support your back. Some
features of the workstation may vary depending on the type of computer work being
performed.
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Below are some guidelines for setting up an ergonomic workstation.

Chair \

Adjust the seat height to suit your equipment. Feet should be flat on the
floor, thighs horizontal to the floor and lower legs vertical.

Adjust the backrest by raising it to the maximum height and then lowering it
until it fits the curve of your lower back.

The backrest should support your lower back, and may also be adjusted
backwards and forwards. When seated in your usual working position, move
the backrest until it has a gentle pressure on your lower back.

There should be at least two centimetres of space between the front of the
seat and the back of your knees. Armrests should be positioned so that they
do not interfere with carrying out your work tasks.

\_ /

Desk \

Keep your head erect when seated at your desk, and ensure that the
surface of the desk is just below elbow height.

If your desk is not height-adjustabile, try to raise your chair so you are
sitting at the correct height, and use a footrest, if necessary, to make up the
difference. Ensure there is clearance between the lower edge of the desk
and your legs, and between the front edge of your seat and your desk.

If your desk is too low, you may be able to extend the legs. You should have
plenty of leg space underneath your desk. Remove bags and bins, as your
legs may become cramped and your posture may become twisted.

Position any equipment or materials you use so that you can reach them
easily without twisting. For example, place frequently used stationery in the
top desk drawer, and ensure your keyboard and monitor sit directly in front
of you to avoid having to twist your body.

\_ /
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Keyboard

\_

The angle of your keyboard can be adjusted to suit you by moving the
supports underneath it. Place the keyboard as close as possible to the front
of your desk. Have your upper arms hanging freely. Your forearms should be
approximately horizontal.

While typing it is best not to rest your wrists, as they should not be bent

up, down or to the side. The knuckle, wrist and top of the forearm should
form a straight line. Wrist supports give you a place to rest your hands only
when pausing from typing, not while you are typing. Do not pound the
keys; instead, use a light touch. Leave enough room on your desk to put the
keyboard out of the way when you are not using it.

Don't place documents between yourself and the keyboard, as stretching
will eventually cause muscle strain in your arms, shoulders and neck.

~

v

Mouse

\_

Place the mouse and mouse pad directly beside your keyboard on the side
you prefer. If you use the mouse frequently, you could try to alternate sides.
You will be surprised at how easy this becomes with practice. Your wrist
should be straight and the desk should support the weight of your wrist,
not your arm. Try to keep your wrist flat and rest your fingers on the mouse
between clicks. Hold the mouse lightly. Don't hold onto the mouse when
you are not using it.

~

)

Monitor

Once you have adjusted your chair and desk, you can position your monitor.
Adjust it so that the top of the monitor is level with or slightly lower than
your eyes. If you can't adjust the monitor to the correct height, place iton a
platform.

The viewing distance should be between 40cm and 70cm. The screen angle
should be adjustable between 85 and 125 degrees. It is best to position the
screen so that you can clearly read the text without having to lean forward,
twist your neck or look upwards. A relaxed viewing angle is approximately
35 degrees. Place a document holder beneath or beside the monitor at the
same viewing distance as the screen.

Also take surrounding factors into consideration, such as reflection, glare
and shadow, when positioning your screen. You may need to use an anti-
glare filter, if necessary.

~

v




Prepare to create a presentation | Topic 1

Desktop layout

Items on your desk, including equipment and resources, should be arranged so
they are within easy reach.

Your desk area can be divided into three zones:

+ the optimum reach zone - the area closest to you, where your hands operate most
of the time

+ the maximum reach zone - items are further away, but still close enough to reach
comfortably

« the outer reach zone - where you may have to bend forward or stand to
reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard,
are close to you. Objects that are used less frequently, such as your phone, should be

out of the way but still within easy reach. Other resources that are rarely used, such as
folders, should be in the outer reach zone.

The following office equipment help maintain good posture at your workstation:

Document holders

Document holders are designed to hold papers and reference material in a
convenient position for viewing.

Place the document holder at a similar level, angle and distance as the
screen to avoid having to shift your eye focus.

Angle boards I

Angle boards allow the user to maintain the correct posture when reading
by reducing the angle between the work surface and the user.

These supports can be adjusted to a suitable height and angle, and enable
comfortable reading with the neck correctly positioned.

Try to keep your neck as straight as possible when you are reading.

)
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Footrests

A footrest may be necessary if you can't place your feet comfortably on
the floor.

Footrests allow your feet to rest at the correct height and on a tilting angle,
which prevents strain on the lower back.

Headsets

If you use a telephone for long periods of time, use a headset. A headset will
keep your neck straight and your arms free.

Headsets prevent you from bending your neck to support the telephone
handpiece.

Standing desks

Standing provides an opportunity for your body to move and adjust, it also involves more
muscular activity than sitting,
Some of the health benefits of standing include:

. alleviating back pain and other repetitive strain injuries by greater use of core
back muscles to support the upper body

« increasing focus, alertness and activity level by releasing restless energy

« reducing the risk of developing cardiovascular disease, diabetes and blood clots,
which can be caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between
sitting and standing. Using a standing desk for hours on end requires your body to adapt.
You may experience sore feet, tired legs and fatigue at first. Wear comfortable shoes and
use an anti-fatigue floor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct
posture while working.

Standing desk recommendations:
Position arms at 90 degrees when standing.
Place the computer screen at eye level and tilt it slightly upwards.
Place the computer monitor at least arm's length away.

Keep your back straight and avoid leaning on the desk.
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There are several things you can do to ensure a safe, comfortable and hazard-free

workplace.

Lighting

Noise

Airflow and
heat

You need to see clearly in order to work effectively. Shifting the screen
angle, adjusting blinds, altering the brightness settings on the screen and
using desk lamps can reduce risks associated with poor lighting. Try to
use natural sunlight rather than artificial lights if possible. If not, keep bulbs
and fixtures clean, focus light on your task and use fluorescent lights to
minimise eye strain and headaches.

Poor lighting may lead to the following hazards:

- Glare - A computer screen positioned in front of a bright window can
be difficult to see.

- Flickering lights - A fluorescent light may malfunction, causing
annoyance, irritation and even nausea.

- Inadequate lighting - Reading in dim light can cause eyestrain.

- Shadows - Shadows shifting across your work area can cause you to sit
with bad posture in order to view your work.

Noise is a problem if it disturbs or distracts employees, causes stress or
interferes with communication or work.

Many offices are open-plan, often with employees seated close to each
other and divided by partitions at chest or head height. Think about noise
levels when you set up your workstation. Remember, people in open-plan
offices still require privacy when they are on the phone and carrying out
their day-to-day tasks., so be sure to factor this in when establishing your
workstation.

Noise can also be a problem outside conventional workplaces, such as
on factory floors and at construction sites. You may have to wear ear
protection if you are required to work in an excessively noisy environment.

There are many ways that noise can be controlled in the workplace.
Examples include:

- noisy machines can be put in a separate room or area

- sound-absorbent materials such as carpet and partitions can be
installed or arranged to deflect and absorb noise

- the volume level on your speakers can be adjusted

Remember that noise is only a hazard when it is stopping you from working
productively, comfortably or safely. Many people prefer to work with low
levels of noise rather than complete silence.

Heating and cooling systems may be hazardous due to poor-quality air or
inadequate temperatures.

Air-conditioned offices often do not have enough fresh air from open
windows. The air quality may need to be adjusted by allowing more fresh
air inside or by improving the ventilation system.

Additionally, office workers frequently complain of being too hot or too cold.
If a person’s desk is near an air-conditioning outlet, the area around their
desk can be much colder than elsewhere in the office. This situation can
usually be corrected by adjusting the heating/air-conditioning settings.
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Vary your activities

Plan your daily tasks so you aren’t doing repetitive work for long periods of time.

Having well-planned working area is pointless if you don't organise your work in a way
that prevents discomfort or pain.

Your work role may involve several different tasks. Some tasks may be repetitive, such
as typing up reports or entering data. If you are able to vary the tasks you carry out
each day, this will help to prevent repetitive actions that cause stress to your body. For
example, if you have to enter a lot of data, break up the repetitive nature of the task

by discussing a project with a colleague, doing some research online or doing another
work task.

You should also take regular breaks. Employees are entitled to take rest periods
throughout the day, including tea and lunch breaks, to reduce stress and fatigue.

Take exercise breaks

Using computers for too long without breaks has been associated with back and
neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day and encourage your colleagues to try
them too. Make sure you are relaxed and stretch gently, without overstretching. Stop if
you feel any pain or discomfort, and remember to exercise both sides of your body. Most
importantly, breathe deeply and evenly throughout the stretch.

Neck: Turn your head gently to look over your right shoulder. Hold for 10 seconds. Now roll
your head forward to look over your left shoulder and hold for 10 seconds. Repeat several
times.

Shoulders: Sitting with a straight back and neck, roll your shoulders forward, then back.
Repeat several times.

Wrists, hands and arms: Interlacing fingers, turn your palms upwards. Now lift your
arms over your head and stretch, leaning gently to the left and then to the right. Repeat
movement several times.

Upper and lower back: In a standing position, place your hands in the small of your back.
Gently arch your back and hold for 10 seconds. Repeat when needed.

Shoulders and arms: Stretch your arms above your head, cradle your elbow with your hand
and gently pull your elbow behind your head. Repeat on the other side, holding the stretch
for 10 seconds.

Eyes: Every 20 minutes, look away from the screen. Focus on a distant object (more than
three metres away).
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Practice Task 1

Question 1

Below is a sample checklist to follow when setting up your workstation.

Read the checklist and make any necessary adjustments to your work area or equipment. You
can ask another person to help you and check your posture. If you are not able to tick some of
the checkpoints, discuss making alterations to your workstation with your manager.

Chair

Is the seat height-adjustable?

Is it high enough to allow you to sit comfortably at the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?
If it has arms, can you still get close enough to the desk and swivel the chair?
Are your feet flat on the floor or are you using a footrest?

I N N N Ny Ny Ny

Are you sitting up straight with the backrest firm against your back?

Q Is it large enough to allow the screen and keyboard to be correctly positioned?
Q Is it low enough to allow you to keep your forearms horizontal or sloping downwards?
Q Is it high enough to allow your thighs to fit comfortably underneath?

Keyboard

O Can it be tilted to allow you to adjust it?
O Are the symbols on the keys clear and easy to see?
Q Is there sufficient space in front of it to allow you to correctly position your arms?

O Does the monitor have easily adjustable brightness and contrast controls?
O Is the image on the monitor stable and flicker-free?

O Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised
to avoid glare and reflections, and help you keep a natural and relaxed posture?

Q Are you sitting far away enough from it for comfort?

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Question 2

Give one example of the purpose of an ergonomic policy?

Question 3

Give four examples of ergonomic procedures you should follow before starting work at your
computer desk.

Question 4

Provide two examples of good ergonomic practices you should follow when producing a large
document that you know will take many hours of keyboarding to complete.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 Determine the purpose, audience and
method of presentation

The purpose, audience and method of your presentation will influence its
content, organisational requirements, style and layout.

You may be required to produce a presentation for an event and collaborate with
another person, such as the author of the information or a specialist speaker. Your
communication with this person will determine the decisions you make when planning
and developing the presentation.

Purpose of the presentation

Before you begin, you need to know what your electronic presentation is about.

Ask questions to make sure you understand what your presentation is about. You should
be aware of the intended message; that is, what you want your audience to know. Your
ability to explain clearly with words, text and graphics determines how clearly your
message comes across. Start by writing a precise statement of the purpose of your
presentation; for example, Thave to explain new health and safety regulations to my
colleagues.

Storyboards

Creating a storyboard can be a good way to help you understand the purpose of
your presentation.

A storyboard is basically an outline of the major points. It should provide a general idea
of where text, pictures or charts will go and the order in which you will present them.
You can quickly sketch a storyboard by hand on paper. Identify items that need to be
presented earlier or later in the final presentation. Look for the most logical flow, or order,
for the information.

You can show your storyboard to the author or presenter and discuss if you have
presented the information in the best order.

Topics of

Title Topic 1 Conclusions

discussion

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Audience

Find out who your audience is and what their information needs are; for example:

Is it an internal or an external client?

Does the group all come from the same department/site or do the same job?
What will they need to do after they have seen the presentation; for example, will
they need to practise a task or skill as part of your planning?

Are there any people with disability or cultural issues that should be considered
when delivering the message?

What sort of presentations worked best for the group previously?

It is also important to find out what level of expertise your audience has on your topic.

For example, if the information is new, don't include technical language , because it may

confuse and bore your audience.

Method of presentation

The method you choose must suit the purpose of your presentation and the audience.
It should hold the audience’s attention and ensure that your information is easy to

understand. You need to consider the best method to present information to your

audience.

Here are several different ways to give a presentation.

Face to face

Presenting information face to face to an audience, such as at a seminar or a staff
meeting.

Specialist speaker

Engaging a specialist speaker/demonstrator for all or some aspects of the
presentation.

Self-running

Choosing a ‘self-running’ mode, such as a looped video that runs continuously on a
TV monitor at an exhibition stand.
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Self-paced

Designing a presentation for people to use themselves, such as at a conference,
training session, or in their own time at their desk. It can be viewed when the
participant chooses to watch the presentation. It may include activities to assess
their understanding of the tasks or material.

Online

Setting up the presentation on the internet or the organisation’s intranet. This allows
for tracking and ensuring information has been accessed by staff or others wherever
they are located.

Practice Task 2

Read the case study, then answer the questions that follow.

Case study

Kate works as an office administrator in a large organisation. Her manager asked her to prepare
an electronic presentation for external clients that explains their upcoming projects, which will be
viewed at the upcoming board meeting.

Kate assumed the clients already knew a lot about the projects and focused her presentation on
the financial costs of each project. . The clients were asked to look at the presentation individually
when they had time in the days leading up to the board meeting.

On the day of the board meeting, Kate set up a computer with a digital projector in the boardroom,
only to discover that the clients had no prior knowledge of the projects and wanted a broad overview.

Question 1

Give two examples of how Kate could have been better prepared before producing the
presentation.

15
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Question 2

What are the consequences of Kate's poor planning?

Question 3

Suggest three possible presentation methods Kate could have chosen.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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1 C Identify the task requirements and use the
best application

In business, procedures ensure timelines are met and a consistent
organisational style is achieved.

Procedures ensure that documents have a consistent style and image so that customers
and business associates will instantly recognise it as belonging to your organisation.
Each time a client has contact with an organisation, they form an opinion based on the
documents or other information they receive.

Policies and procedures are used so staff will have clear guidelines to follow, including
style guides and templates for producing documents, such as using a clearly defined and
documented style guide.

Conforming to organisational requirements will also ensure you are able to complete
your work in an efficient and timely manner. It is very frustrating to spend hours working
on the design of a document, only to find it does not meet requirements. Speak to a
colleague or your supervisor if you are unsure.

Common organisational requirements

The requirements appropriate for one organisation may not suit another; for example, a
law firm’s requirements would be different from that of a sports equipment retailer.

Most organisations outline document production procedures and guidelines either in
their policies and procedures manual, or in an in-house style guide. A style guide will
provide details of the way the organisation wants its document to be structured.

Your supervisor can assist you to find the correct template, identify where the style guide
is stored and rules about its use.

The way you work and collect information will be determined by the policies and
procedures in which you operate. For example, your organisation may have guidelines
about how to communicate with external clients or the way information can be shared.

You must also be informed of any legislation that may apply to the information in your
presentation. For example, copyright rules when accessing someone else’s ideas or
original work such as an image or design. The author has the right to determine the
conditions this work can be used by others.

You may need to confirm your actions with a supervisor to make sure you are following
correct procedures for gathering information.

17
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To prepare appropriate documents for your organisation, you must follow established

guidelines and procedures for production.

Established procedures may include:

using templates

including the organisation’s logo or version control in the footer

referring to the organisations style guide

observing copyright legislation that restricts the use of someone else's work

delivering the content in the required format.

Equipment for completing the task

You need to use equipment, such as a computer or laptop, monitor, projector, keyboard

and mouse, to deliver an electronic presentation. The following provides some more

information about equipment you might use.

Data projector or
display monitor

Digital pointer or
annotation pen

Sound equipment
and visual
monitors

Network/internet
access

Microphones

A digital projector can be attached to a computer or tablet to project
the display onto a larger screen. A data projector is commonly used

for PowerPoint presentations, but it can be used to display almost any
digital multimedia. Large digital monitors or televisions can be used
instead of a projector via direct cabling or through a local area network,
Wi-Fi network, internet or other wireless technology such as Apple TV.
Always test the equipment before the presentation and ensure that the
presenter is competent in using it.

When presenting information you might want to draw attention to an
important point on the screen. A handheld digital pointer can help you
do this.

PowerPoint and a variety of other computer and tablet applications
have freehand annotation tools that allow the presenter to write on
each presentation slide during the presentation. This can add or draw
attention to existing information.

Audio speakers are often required even in smaller rooms, particularly

if your presentation has a video clip or uses sound effects. Sometimes
in a large venue it is necessary to install a background screen or extra
screens around the room so that all participants can see a visual display
clearly (without straining) by looking towards a stage area.

To illustrate certain points you can provide a hyperlink to a video. This
may require you to arrange with your IT department to access logon
privileges.

You may consider the use of a handheld microphone to help the
audience participate fully. Assistants can be organised to minimise
delays and avoid reducing the impact of the session. A lapel
microphone can be used for the speaker if they are not using a lectern
and standing in one place while they present information.
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Speaker notes - Having a hard copy of the presenter’s notes, internet documents or
and handouts audience handouts can add value to an electronic presentation.

You may have to write speaker notes or handouts for a presentation
that you are giving. Speaker notes are thumbnail sketches of each slide
to be displayed. They help the presenter remember the important points
on each slide. This helps the verbal presentation run smoothly.

The audience may also require handouts to repeat or add to information
from the presentation. Handouts can be formatted in a variety of ways
and can contain your notes and a space for the audience to add their
notes.

Handouts can also be provided in digital format either before or after
the presentation. With the advent of smartphones and tablets, many
people consider an electronic version to be preferable as it reduces

paper wastage and is easy to store and access from a mobile device.

Selecting a suitable application

The most commonly used software for presentations is Microsoft PowerPoint,
although some organisations prefer to use other programs.

The examples given in this learner guide are based on PowerPoint 2019. Earlier versions
will be similar in how they work, although there may be some differences in the
appearance of the screens.

The choice of application will depend on a number of factors, such as the cost of the
software which may come as part of a package. For example, Microsoft Office 365
contains Word, Publisher, Outlook and PowerPoint, as well as a range of other programs.
The application you are required to use may also depend on the platform used by the
business, which may be based on the nature of the business and the available resources.
For example, an organisation may predominantly use Microsoft software, but may also
have one or more Apple computers with other software installed.

The following table outlines some of the key features of different presentation software
programs.

Presentation software Key features

Microsoft PowerPoint - Available as desktop software, online application and mobile app

Able to access external data sources such as photos, images,
charts, animation, cinematic motion, 3D models and icons

»  Provides various templates
Allows cinematic transitions and effects for objects and text

Able to communicate with other Microsoft Office programs,
including Word and Publisher
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Presentation software Key features

Prezi

Keynote

Google Slides

Provides templates in themes of template styles

Flexibility in the organisation and presentation of slides through a
digital map

Keeps track of who is viewing the presentation and what slides
they are interested in

Available as desktop software, online application and mobile app
Cloud-based, where multiple users are able to work in the
document at once to collaborate on tasks

Provides various templates

Able to access external data sources such as photos, image
galleries, equations, charts, and a library of over 600 customisable
shapes

Available as desktop software, online application and mobile app

Able to communicate with other Apple programs such as Apple
Pencil

Compatible with Microsoft PowerPoint

Allows cinematic transitions and effects for objects and text
Cloud-based, where multiple users are able to work in the
document at once to collaborate on tasks

Available as desktop software, online application and mobile app
Keeps track of revision history

Coverts PowerPoint files to Google slides

Variety of templates available

There are many organisational and reporting requirements, which will be outlined in

organisational policies and procedures. This information may be used to determine

the resources available to the company, including the specific software they can use.

Be aware of the spreadsheet software used in your organisation, and ensure you follow

organisational policies and procedures.
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Practice Task 3

Read the case study, then answer the questions that follow.

Case study

Phuong works as an administrative officer for a local council. She has recently moved into a
different department and is looking forward to the change. Phuong has been asked by her
supervisor to create a presentation with accompanying handouts that summarises the number and
types of small businesses in the area. She has also been asked to set up the presentation room.
Phuong is familiar with creating presentations using the software; however, she is not sure how to
find out the information to include in the report.

Phuong speaks with her supervisor to clarify what is required. Phuong's supervisor explains that
a report is completed annually, so she should be able to access last year’s presentation from the
network drive. However, her supervisor is not sure of the file name or where it has been saved.
Her supervisor suggests that she follows the same layout and presentation as last year's report,
although she will need to update the logo.

Phuong's supervisor explains the presentation is required at the next management meeting,
one week from today. She would like to see a draft a week prior to review the information. Once
approved, fifteen copies of the handout need to be produced.

Question 1

What is Phuong’s task?

21



BSBTEC303 | Create electronic presentations

Question 2

What does Phuong do to clarify task requirements?

Question 3

What equipment will Phuong need to complete her tasks?

22 Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Summary

The aim of ergonomics is to reduce the risk of injury by applying safe work
practices.

Your work environment can be organised in accordance with ergonomic
requirements by adapting workstations, tools and equipment to meet your needs
and ensuring a safe, comfortable and productive work environment.

Organise your work tasks to ensure you have a balance of repetitive and other
activities, regular rest periods and exercise breaks.

The factors that are important for your planning include the purpose, audience
and method of presentation. These influence the content, organisational
requirements, style and layout of the presentation.

A storyboard will help you plan and outline the best order of information in the
presentation.

Find out about the audience and what their information needs are so the
presentation you develop will be more successful.

Consider the most useful method for the audience to receive the information and
retain it, rather than assuming it will be enough if they've seen it.

Procedures ensure that documents have a consistent style and image so that
anyone receiving material from your organisation will instantly recognise it as
belonging to your organisation.

Many organisations have policies and procedures for staff to follow, including
style guides and templates for producing documents.
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Learning Checkpoint 1
Prepare to create a presentation

Part A

1. For each of the following issues related to a poorly set-up workstation, suggest at least one
solution that could help to prevent or relieve it.

Sore neck and shoulders
Sore back

Sore wrists

Eye strain

2. List four types of office equipment (other than a chair and desk) that can be used to set up an
ergonomic workstation.
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3. Outline one procedure that can be used for the preparation of presentations.

4. Select true or false for each of the following.

a) Confirm the purpose of the presentation with the content
author or presenter before you begin planning the presentation.

b) Handouts are useful for providing the audience with some
notes so they can recall important points from the presentation.

c) An audience will usually have the same level of expertise in
the topic as you, so you should pitch your presentation to the
content you are comfortable with.

d) If you know how to use a computer, you will be able to use
a data projector.

5. Choose two pieces of equipment needed to make or share a presentation.
features of each of these items of equipment,

» True » False

» True » False

» True » False

» True » False

Briefly outline the

25
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6. Briefly outline the main features of two different types of software applications used for
presentations.

Part B

Read the case study, then answer the questions that follow.

Case study

Angelina works in an office and is responsible for answering customer enquiries over the phone
and redirecting the calls to relevant personnel. Most days, Angelina’'s manager gives her urgent
work in the afternoon that needs to be completed that day. Her timelines are always very tight,

and she often finds that she has to work during her lunch hour and for an extra half hour in the
evening. Angelina often finds that work is often just dropped on her desk, which makes her desk
disorganised and difficult to use. She can't adjust her chair to suit her body, and the phone cord is
too short for her to reach without stretching. Angelina often finds she is cold as her desk is close to
the front door of the office.
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1. List at least three unsafe work practices Angelina experiences.

2. Suggest a solution for each of the unsafe practices you listed above.
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2A
2B
2C
2D
2E

Follow task and organisational requirements
Use software functions

Add balance and visual impact

Use features to customise for the audience
Overcome issues using help functions
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2A Follow task and organisational requirements

Whatever your work task, you will always have to work within a designated
timeline.

Always find out when the presentation is required and plan the task to work out how
long it is likely to take. Careful planning means there will be no last-minute panic. If you
are developing an electronic presentation for someone else, always ask when a draft of
the material is required. The presenter will generally want to rehearse the material. This
might result in further amendments or adjustments.

When planning your presentation, consider the purpose of the presentation, the audience
and the presentation method you will use.

Here is a review of the information you need to start planning the presentation.

Purpose - What is your presentation about?
Why is it needed?
If you are in the workplace, discuss the purpose with your manager.

Audience - Clarify the audience for your presentation; for example, colleagues at work or
fellow students.

Once you identify your audience, decide how much they already know about
the subject you have chosen. This will help you determine how complex the
content of your presentation should be.

Method of = Will it be shared online or face-to-face in a meeting?
presentation . poes it require speaker and handout notes?

When this information has been clarified, you can prepare the content of your
presentation using a storyboard. Here is an example:

+ Slide1 Title page with graphic

+ Slide 2 Introductory page, bullet points for three major topics

« Slides3-5  Content for topic 1

« Slides6-8  Content for topic 2

« Slides9-11  Content for topic 3

« Slide 12 Conclusion
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Corporate image

When creating a presentation, you need to be aware of your organisation'’s
preferred style.

There may be particular requirements you have to follow. For example, you may have to
include the company’s logo in the top left-hand corner of the slide and use the company’s
corporate colours throughout. to create a consistent and professional image.

Companies can use different logos and variations on the designs for specific purposes, or
for special areas of their company’s activities. For example, one version of the logo may be
used in an email signature and another on social media. Notes for the presentation may
need to have a specific layout, or graphs may require a certain colour.

You may need to discuss this with a supervisor or the marketing and communications
team to check which style is appropriate for a particular circumstance.

Organisational style guide

An organisational style guide will provide you with the specifications,
instructions and design details for the format and final look of your presentation.

The purpose of the organisational style guide is to ensure consistency in the presentation
and any documents produced by the organisation. This may include using standard
templates or using the corporate letterhead or logos in appropriate places in your
presentation.

Style guides may also outline rules for the type of words that are used in the slides, notes
or handouts. For example, acronyms and jargon may be appropriate for internal staff, but
may not be appropriate to be presented to customers or the general public.

Here is a list of other instructions included in a style guide:

Layout and design:
- Alltitle and topic headings must be in Cambria bold, size 40 pt font in dark blue.
« All other headings must be Cambria bold, size 36 pt font in light blue.
+  Body text should be Arial size 20
« All headings and body text should be left-aligned.

« Each slide should contain one picture, graph or SmartArt.

Numbers and dates:
+ The date style is Day Month Year, e.g. 30 June 2001.

« Time should appear as 8am or 8.30pm.
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Bullet lists:
«+ Each bullet point should begin with a capital letter and have a full stop at the end.

Abbreviations:

« Introduce an abbreviation by writing it out in full the first time, followed by the
abbreviation in brackets. Just use the abbreviation after that.

In many cases, if a standard template is used, predefined styles will automatically appear
in the slide. Clarify the use of style guides for your organisation with your supervisor and
colleagues.

Presentation templates may include layout and design information such as:

Header and footer size

Heading details such as type and size of font

Colour schemes

Maximum or minimum font size

Recommended font types

Spacing of text and paragraphs

Specific layout designs

Location of company logo and slogans or other information such as version numbers
Specifications on imported video

Use of images, including sizes and dimensions

Style can also relate to sounds, music and overall content. All of these must align
with the chosen corporate image and create a clear message to the audience about

company values.
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Organisational style

Jenni has recently been employed as a marketing assistant for an ad agency called
Impact. The company often uses presentations to communicate to the clients. Jenni
will use the standard templates to prepare for a meeting, but she will need to change
the colour scheme to reflect the corporate colours of the client.

Here is a sample of the electronic design requirements contained in the template that
Jenni will need to use:

The company logo should appear on the top left.

The date should appear on the bottom right.

One heading should be used per slide.

All headings to be Arial and all text to be Times New Roman.
All headings to be bold and in font size 24.

All body text should be in font size 16.

There should be approximately three bullet points per slide.
Use square bullet points.

Images must reflect and promote the content.

Practice Task 4

Question 1

Which

OO0 O0O0

of the following statements relate to presentations? Tick all that apply.

A company may have a logo used for each of their clients.

Style and layout guides help maintain a consistent corporate image.

Standard templates have predefined styles that automatically appear in the
document,

Images are used to help make the audience laugh.

A style guide aims to create a clear message to the audience about company
values.
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Work to a deadline

Whenever you are given a work task, you need to determine a timeline for its
completion.

A timeline is a plan for how long a task will take to complete. It also breaks the task into
steps and details when each step needs to be completed by. Using a diary system and a
to-do list can help you to prioritise tasks and keep on top of the timelines required for
set tasks. For example, you may have to print hard copies of the handouts the day before
the presentation so they can be delivered to the venue, or your organisation may require
you to book in a printing job that may take a couple of days to be completed, e.g. printing
double-sided and in colour.

In many cases, timelines are set and agreed with your stakeholders:

« Internal stakeholders are those that work at the same organisation as you, and
may include colleagues in other departments, managers and supervisors.

- External stakeholders are those that are outside the organisation, including
customers and suppliers.

Often your manager or supervisor will give you a deadline for completing a set task (e.g.
prepare a draft letter by 2pm). Alternatively, you may have deadlines for completing
regular work tasks, e.g. completing a monthly sales report or sending letters to customers
who are overdue in paying an invoice by a certain number of days.

Meeting a deadline demonstrates your competency in undertaking tasks and
demonstrates your professionalism. Make sure that when deadlines are set, they are both
achievable and realistic.

If you have concerns that a deadline might not be met or you have conflicting work
priorities, discuss this with your manager or supervisor as soon as possible. They may be
able to assist you by suggesting how the deadline can be met or agreeing to adjust the
timeline for the task.

Preparing presentations will become less problematic once you are familiar with the
requirements of your organisation.
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The following table is an example of a useful planning checklist.

Task Deadline Requirements Tick when
completed

Prepare an 10 May Follow order outlined in
electronic storyboard.
presentation for
Kyle for the board
meeting.

Use organisational style guide
including company logo and
colours in headings and banners.

Use Arial bold for headings and
Times New Roman for text.

Draft ready by 7 May for rehearsal.

Print 17 copies of handouts after
final review.

Practice Task 5

Question 1

Number each step from 1to 6 in the order you would follow to plan a presentation.

Prepare slides.

Complete final presentation.

Discuss the purpose and method of the presentation with a manager or author.

Review key points with the author.

Put storyboard together to outline key points.

Review slides with the author.

OO0 0OO0
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Question 2

If your manager made some new demands for the presentation at the last minute, what might
be the effect on your work?
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2 B Use software functions

To design a professional and interesting presentation, you need to learn about
the various software applications and features available to you.

Although there are many different systems for producing presentations, this Learner
Guide will primarily focus on PowerPoint 2019.

Here are some of the functions you will be able to use to develop your presentation using
PowerPoint:

« create a slide show

+ apply a design template

+ add content to slides

+ write or draw on slides

« apply a style to slides

« create handouts and speaker notes.

Check the readability

It is easy to overuse many of the features and functions available in PowerPoint
software.

If your electronic presentation is too busy, it can distract your audience from the content
and message. Try to keep the presentation clear, concise and easy to view on the screen.
Your handouts will be a useful reference for the audience and can be used to expand on

information if necessary.

The font size used in a presentation is larger than the font used in a regular Word
document to allow people to view it from a distance. Projecting the slideshow onto a wall
or screen allows for a good size magnification and improves readability.

If the content of your presentation is ‘heavy going’ for your audience(e.g. it has a large
amount of words and details), you can help to break up the content with an image or
quote relevant to the subject being delivered; you may also use a chart or diagram. This
will enhance readability and maintain the interest level of the participants.

Always keep the audience in mind when making design decisions. For example, consider
whether the presentation needs to be formal and professional to share with customers or
clients.
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To improve the readability of your presentation, avoid:

heavy or dark colours

not enough colour contrast between the main text and the background
distracting animation of words or illustrations

irrelevant illustrations or images that don't relate to the content

multiple transitions either within a slide or throughout the whole presentation
dominant background

overuse of sound

too many words per slide

too many small or varied fonts.

PowerPoint functions

Before you start to design your presentation, you should become familiar with
some key PowerPoint functions and terminology.

PowerPoint uses slides to build an electronic presentation. A slide is a single frame

in a presentation and a presentation comprises a group of slides. Look at some of the

functions listed below.

Placeholders Boxes with dotted lines that appear when you create a new slide. This

is where you add your text or content, such as an image or chart.

Slide master Allow you to change the style of text and have the style reflected

throughout the whole presentation.

Notes master Allow you to create notes that accompany your presentation.

Importing Allow you to import information from other applications such as

Microsoft Word or Excel, as well as images or graphics.

Handout master Allow you to create handouts to go with your presentation.

Colour schemes Provide a selection of background colours that you can apply to your

presentation.

Templates Offer colour schemes and text formatting to design a presentation

with a particular look. You can alter the colours and text formats
chosen within the template itself.

Hyperlinks Allow you to create a link in the presentation to another slide in that

38
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Practice Task 6

Question 1

Which of the following statements relate to avoiding distractions in a presentation? Tick all that
apply.

Keep text simple and use notes for additional details.
Check readability by testing that the size of the font is suitable.
Use lots of images and charts to brighten up a slides and add interest.

Make sure there is a contrast between the main text and the background.

OO O0O0O0

Research the latest music hits to use as a part to the slides.

Question 2

Use PowerPoint to create a slideshow for your presentation by following these steps.

1.

Open a blank presentation in PowerPoint. Select a layout for your slide by selecting the
Layout drop-down menu in the Home tab. The option below is for a title and subtitle to be
used.

2. To add content, simply click inside the placeholder (rectangular box) and enter the text you

want.

Click to add title

Click to add subtitle

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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3. To add additional slides that you need for your presentation, click New Slide in the Home
tab.

4. To style a slide, select the Design tab from the ribbon and choose the slide style best
suited to your organisation and the content.

5. Save your presentation using a suitable name.

Applying and creating templates

Templates store design information that you can apply to a presentation to
consistently format the content on all slides.

When you create a template in PowerPoint, you create a .potx file that captures any
customisations you make to a slide master, layout and theme combination.

Below is an example of a template.

Aut hoto all YYYvyvy

This template contains placeholder content ‘Autumn Photo Album’ It also contains
formatting, colour, background and layout features.

Each template contains a slide master that must have at least one layout (but can
contain more) for you to use in a presentation. While the template above was created by a
designer, you can create a template by creating one or more masters, adding layouts, then
applying a theme.

To create a template, go to the Design tab. If you want to use a default slide master,

choose one from the designs shown at the top of the screen.

Note: If you want to add another slide master or create a new slide master, refer to
PowerPoint help menu search feature by typing ‘create new slide master’ into the
space next to the magnifying glass icon. This will take you to this topic and other
recommended topics with instructions to follow.

Q Tell me what you want to do
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Apply a layout by using the standard layouts that are built into PowerPoint 2019. If you
want to customise your layout, refer to ‘layout’ in the help menu.

Once you have finished creating a template, go to the File tab, and then click Save As.
Choose where you want to save the file. In the File name box, type an appropriate
file name. In the Save as type drop-down menu, click PowerPoint Template, then
click Save.

Background styles

Background styles are background fill variations from different combinations of
theme colours and background intensities in the current document theme.

Theme colours, theme fonts and theme effects make up a theme background. A theme
may be applied to a file as a single selection.

Click on the relevant slide to add a background style to your presentation. To select
multiple slides, click the first slide on the left, then press and hold Ctrl while you select
the other slides.

e

] &3
o = Slide Format

Size ~ Background

o= Ao
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Variants Customize

In the Design tab, click the arrow in the Variants group to open the drop-down menu.
Hover over to Background Styles to view the options.

-

L

-

Right-click the background style you want, and then do one of the following:

To apply the background style to the selected slides, click Apply to Selected
Slides.

« To apply the background style to all of the slides in your presentation, click Apply
to All Slides.
To replace the background style for the selected slides and any other slides in the
presentation that use the same slide master, click Apply to Matching Slides. This
option is available only when your presentation contains multiple slide masters.
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Click to add title

Cick 1o odd fext

Practice Task 7

Question 1

Take the following steps to add content to your presentation.

1.

Open your presentation and select the Home tab. Select the title slide. Click inside the
placeholders and add a title and subtitle.

If you have chosen to use a title page with a graphic, select a suitable graphic via the Insert
tab. There are various options available for inserting images and graphics. For example,
you can select the Pictures icon to insert a picture saved on your computer or click Online
Pictures to search for particular types of pictures.

Go to each of your slides by clicking on the thumbnails and add the content. You might also
like to insert a graph by click using the Chart icon or format content by clicking SmartArt
and selecting from the options.

View your presentation by going to the Slide Show tab, then click From Beginning. In this
view you can see the slides as they will appear in your presentation. To move from slide to
slide, you can press Enter, the Spacebar or an arrow key, or simply left-click your mouse.

If you want to change the sequence of your slides, click View, then Slide Sorter. This view
allows you to see all your slides at once. You can click on and drag slides into a different
sequence.

Save your presentation.
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Here is an example of a slide displaying a title, content, graphics and a standard design template.

Management
training
presentation

For leaders and managers

pAth

Write or draw on slides

When you are playing your presentation you might like to circle, underline,
draw arrows or make other marks on the slides to emphasise a point or show
connections.

To write on slides during your slide show, select the Slide Show tab and click From
Beginning to start your presentation. Right-click the slide that you want to write

on. A drop-down menu will appear. Go to Pointer Options, and select either Pen or
Highlighter. Hold down the left mouse button and drag to write or draw on your slides.

You can change the pen or highlighter colour by right-clicking the mouse and hovering
over Pointer Options, then Ink Color. Select a colour of your choice.

Company Logos

---------

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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To remove some or all of the pen or highlighter, right-click the slide and go to Pointer
Options to select either Eraser or Erase All Ink on Slide. From here you may also hover
over Screen and select Show/Hide Ink Markup.

To turn off the pen or highlighter, right-click the slide, go to Pointer Options and click
the Arrow.

At the end of the slide show presentation, you will be prompted to either keep or discard
the changes you made using a pen or highlighter. Choose one of the options to exit the
slide show.

Apply a style

Once you have added the content to your presentation, you can apply a style.
This will ensure the format is consistent throughout the whole presentation.

To apply a style, you will need to use the Slide Master. The Slide Master is similar to
a template. It allows you to choose a style and format the text. These choices will be
reflected throughout the whole presentation.

You can also modify the header and footer on the Slide Master to include text, slide
numbers and the date and time. There are placeholders for each of these elements.

R B =

Click to edit Master title style

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Practice Task 8

Question 1

Which of the following information may be subject to confidentiality?
Tick the correct responses.

To apply a consistent style to your presentation, follow these steps.

1,

Select the View tab, then click Slide Master. You should see a screen similar to the
following.

Inside the placeholder, click on the top placeholder to add a heading. This will be the
heading on all subsequent slides. However, you can still edit it if necessary when you
switch to Normal view. Choose formatting to suit your title from the Format tab. By
hovering over different WordArt styles, you can see the impact the style will have on your
title. Select a WordArt style.

Click on the second placeholder and add text. Choose formatting to suit your text from the
formatting toolbar. If you have written different levels of text, choose formatting to suit all
levels.

To view your choices, select the View tab, then select Normal. If you are unhappy with your
choices, go back and alter them.

To add footer information, select the Insert tab, then select Header & Footer. Tick the Date
and time checkbox. The Update automatically button will be selected. This will make sure
that the date and time on your presentation is always correct.

Tick the Footer checkbox and click inside the box to add a suitable footer for your
presentation. Click Apply to All.

View your new style by going to the Slide Show tab.
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Practice Task 9

Read the case study, then complete the task that follows.

Case study

You have recently been employed as a marketing assistant for an organisation that manages
marketing campaigns and provides marketing and promotional advice to clients.

The marketing manager has asked you to prepare a presentation for the marketing team, which
consists of 10 staff from four different areas of the organisation. The purpose of the presentation is
to communicate a marketing plan that has been developed for a client.

You need to include:

a description of the product and the variations in the range, including its special features, logo
and corporate colours

sales analysis figures for the last five years in an Excel spreadsheet

the characteristics of existing and potential customers

a description of the competitors and their market share

market research outlining current market industry trends and market share
the marketing budget

a marketing strategy, including an advertising plan and promotional plan
the pricing strategy

a schedule of tasks with allocation of responsibilities.
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Question 1

Develop a storyboard to plan the presentation, ensuring that all information will be covered.
The presentation should be no more than 20 slides.
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2C Add balance and visual impact

You can add visual impact and emphasis to certain parts of your presentation.

It is important to find the right balance when choosing the type and number of features
to use. They can easily be overused and distract from the information you are trying to
communicate. But, when used in the right way, they can create visual appeal and draw
attention to important information.

Here are descriptions of several different presentation features.

Transition

This controls the way slides are presented. For example, they might enter from the
left to the right or from the right to the left.

Animation

This defines how content on the slide is presented. For example, text can fly into or
dissolve on the slide.

Graphics

Images, charts, diagrams or photos can be inserted to add colour and visual impact.

Timing and pace

You can automatically control the transition time between each slide or when certain
animations will occur.

Music, sound and video

Video and audio files can be added to enhance a presentation.
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Slide transitions

Slide transitions are the effects that occur in Slide Show view when you move from one
slide to another. You can control the speed of each slide transition effect, and you can
also add sound when changing slides.

PowerPoint includes many different types of slide transitions, including:

No transition « Blinds horizontal
Blinds vertical - Boxin

Box out « Checkerboard across
Checkerboard down «  Comb horizontal

Comb vertical

To add a slide transition, go to the Home tab and select a slide thumbnail (ensure you are
in Normal View).

Select the Transitions tab and choose a slide transition effect.

To set the slide transition speed, in the Timing section, change the settings in Duration
to increase or decrease the speed.

Click Apply to All to add the same slide transition to all of the slides in your
presentation.

To add different slide transitions to the slides in your presentation, repeat these steps for
each of your slides.

To add sound to slide transitions, click the arrow next to Transition Sound. To add a
sound from the list, select the sound that you want. To add a sound not found on the list,
select Other Sound, locate the sound file that you want to add, then click OK.

To add different sounds to each slide transition, click on each slide and select a sound
from the drop-down menu.
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Adding graphics and illustrations

You can easily insert photos from file or online, shapes or charts.

Graphics can be included in your presentation by selecting the Insert tab and choosing
from the Images and Illustrations groupings.

You can also use a feature called SmartArt to include graphics in your presentation.
A SmartArt graphic is a visual representation of your information that you can
create quickly and easily, choosing from among many different layouts, to effectively
communicate your message or ideas. For example, you can insert hierarchical charts,
pyramids or arrows with text.

To add an illustration, go to the Insert tab and click SmartArt.

Shapes Icons 3D SmartArt Chart
v Models ~

Illustrations

In the dialog box, click the type and layout you want. You can enter your text either

by clicking in a shape in your SmartArt graphic and typing your text in directly or by
opening the Text Pane from the Design tab under SmartArt Tools. The text you enter for
each bullet point will appear in different parts of your SmartArt graphic.

Animation

Limit the use of animation to prevent obscuring your message.

However, you may wish to add animation to your SmartArt graphic to draw the viewer’s
attention or stimulate interest. For example, you can make a shape fly in from one side of
your screen or slowly fade into view.

To decide which animation works best with the layout for your SmartArt, view your
information in the SmartArt graphic Text Pane, since most animation starts at the top of
the Text Pane and moves down. You can also play an animation in reverse order.

The animations that are available depend on the layout you choose for your SmartArt
graphic.

To animate your SmartArt graphic, click on it then go to the Animations tab and select
the animation you want to apply. You can customise an animation using Effect Options
in the Animation section. Here, you can choose to animate all of the shapes in the
SmartArt at once or one shape at a time.



Create presentations | Topic 2

To add sound, go to the Animations tab and select Animation Pane. A panel will
appear on the right. Click the arrow next to the and select Effect Options from the drop-
down menu.

In the dialog box, click the arrow next to Sound, then either select a sound from the list
or select Other Sound... to locate a sound file on your computer.

Animated items are noted on the slide by non-printing numbered tags. These tags
correspond to the animations in the Animation Pane, which appear only in Normal
view with the Animation task pane displayed.

You can view your animations at any time by going to the appropriate slide and clicking
the Preview button in the Animations tab.

Timing and pace
The timing and pace of a presentation are important to get right.

You may choose to manually control how the slides and content of your presentation will
be displayed. Alternatively, you can pre-set the time and pace using PowerPoint. Using
this function, you can have slides that appear after a certain amount of time has passed.
The amount of time you set will depend on how much information is contained in the
slide, and how much emphasis you want to place on the information. You may need to
check this with the person delivering the presentation. Ask them how much time they
want to have between slides.

It is a good idea to rehearse your presentation to ensure it meets the required time
frame. To do this, you can record the time that you need to present each slide, then use
the recorded times to advance the slides automatically when you are actually giving the
presentation.

To do this, go to the Slide Show tab, then click Rehearse Timings. The Rehearsal
toolbar will appear, and the Slide Time box will begin timing the presentation.

Recording v X

= QI 0:00:06 € 0:00:06 |[«—— Total time for presentation
A A A A

Next Pause Slide Time Repeat
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While you time your presentation, you can take the following actions:

« To move to the next slide, click Next.

- To temporarily stop recording the presentation, click Pause, then click Pause
again to continue recording.

 Torestart recording the time for the current slide, click Repeat.

« After you set the time for the last slide, a message box will display the total time
for the presentation and prompt you to do one of the following:

« To keep the recorded slide timings, click Yes.
« Todiscard the recorded slide timings, click No.

« 'The Slide Sorter view will then appear and display the time recorded for each slide
in your presentation.

If you do not want the slides in your presentation to advance automatically by using the
slide timings that you recorded, you can turn the slide timings off by going to the Slide
Show tab and deselecting the Use Timings checkbox. You can turn the slide timings on
again by ticking this box.

Music, sound and video

To make a multimedia presentation you can add music, sound or video.

These can be added from files on your computer. Ensure speakers are properly set up to
be able to play sound and music in your presentation.

To add music or sound to your presentation, view the presentation in Normal view. Go to
the Insert tab and select Video or Audio from the Media group.

Video may be located either online or on your computer or device. You can choose to
either record your own audio to insert your own audio.

Once you have inserted a video, a message will be displayed. If you want the video to play
automatically when you go to the slide, click Yes. If you want the video to play only when
you click the video icon during a slide show;, click No.
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Practice Task 10

Question 1

Which of the following statements relate to adding visual impact to a presentation?
Tick all that apply.

O0O00O000O0

A transition is the style used to move from one slide to another.

The same transitions must be applied to all the slides in your presentation.
Graphics that can be inserted include photos, shapes, cartoons and charts.
Charts, pyramids or arrows can be inserted using SmartArt.

Animation is the best way to add interest to a presentation.

A presentation must be in slide view before inserting sound or video.
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2 D Use features to customise for the audience

Streamline and customise your presentation to meet the needs of different
audiences.

Software features include basic and hyperlinked custom shows. Custom shows allow you
to adapt a single presentation for a variety of audiences. You can use a custom show to
present or create a hyperlink to an independent group of slides in your presentation.

A basic custom show can be a separate presentation or a presentation that includes some
of the slides from another presentation. A hyperlinked custom show provides a quick way
to navigate to one or more separate presentations.

The custom shows feature gives you the flexibility to choose which sections you present
to which audience type without having to create totally separate versions of your
presentation.

For example, a group requires:
+ only a brief introduction and more detail at a later date.
« an extended introduction and background, before the detail is provided.

. additional supporting material such as charts or data.

Custom shows

A custom show gives a more targeted presentation to a group.

For example, if your presentation contains a total of five slides, you can create a custom
show named Custom 1 that includes just slides 1, 3 and 5. You can create a second
custom show named Custom 2 that includes slides 1, 2, 4 and 5. When you create a
custom show from an original presentation, you can always run the entire original
presentation in the correct order.

Slides for

Custom 1 |

Slides for

Custom 2

Ooooo
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You can use a hyperlinked custom show to organise content in a presentation.

For example, if you create a primary custom show about your company’s new overall
organisation, you can then create a custom show for each department within the
organisation and link to this show from the primary presentation.

8 0. ...
B8 O

Primary )
show with i

@ \EF Custom B

0 O

You can also use a hyperlinked custom show to create a table of contents or agenda slide.
This is similar to a webpage in that it is an index of your presentation from which you
can create hyperlinks and move between the different sections of your presentation and
back again.

To create a custom show, go to the Slide Show tab and click Custom Slide Show, then
select Custom Shows.

In the Custom Shows dialog box, click New. Under Slides in presentation, select all the
slides that you want to include in the custom show, then click Add.

To change the order in which slides appear, under Slides in custom show;, click a slide,
and then click on the arrows to move the slide up or down in the list.

Type a name in the Slide show name box, then click OK.

To preview a custom show, click the name of the show in the Custom Shows dialog box,
and then click Show.

To preview a custom show, go to the Slide Show tab and click Custom Slide Show. Then
select the name of the custom show from the drop-down menu.

You can also click Set Up Slide Show. In the dialog box under Show slides, click Custom
Show, and then click the custom show that you want to present. Click OK. The custom
show you have selected will now be presented when you play the slide show.
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Practice Task 11

Question 1

Which of the following information may be subject to confidentiality? Tick the correct
responses.

Take the following steps to create a hyperlinked custom show.

1,

2.
3.

Open or create a presentation with a minimum of five slides.
Select the Slide Show tab and click Custom Slide Show, then select Custom Shows.

Select New and, under Slides in presentation, tick the title slide and three additional slides,
then click Add.

Arrange slides in the order you desire by using the arrows to move the slides up or down.
Next to Slide show name, type ‘Custom show 1/ then click OK.

On the title slide, type ‘Go to custom show". Select the textbox and click on the Insert tab,
then click Link.

In the dialog box, select Place in This Document. Select ‘Custom show 1’ from the menu,
then tick the Show and return checkbox and click OK.
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2 E Overcome issues using help functions

If you require information or instructions on how to do something, you can hover
over different icons with your mouse or seek assistance in help.

You might want tips on using your keyboard or your mouse. Or you might want
information on using the features of the program more effectively.

Microsoft PowerPoint 2019 provides a description of each icon or function on the screen
which can be displayed by hovering over the icon.

Alternatively, you can ask for help at any time by pressing the F1 function key or by using
the search box. Simply type in the keyword or phrase that you need help with in the
search box at the top of the screen, and a list of options will be displayed to choose from.

You can navigate the help window in the same way you would navigate the internet in a
web browser, by clicking hyperlinks to different pages.

Taking screenshots

It can be helpful to take a screenshot to communicate the issue you are having
to someone else.

A screenshot captures the image of your computer screen in its current state, including
any error messages that are being displayed. If you are having a particular issue with
your computer that is difficult to describe, it can be useful to take a screenshot and send
this image in an email to the IT department or a colleague who may be able to assist.

To take a screenshot, press the print screen icon on your keyboard. This may be displayed
as an abbreviation, such as PrtScn’. Then simply insert the image into an email by
pressing Ctrl+V on the keyboard or by right-clicking the mouse and selecting Paste from
the drop-down menu.

If you are using two screens, the image will show both of your screens. You .

. . . i
may need to crop part of the image to focus on the issue you are having, such P
as an error message. To do this, click on the image and under the Format tab, Crop
select Crop. Then you can simply drag the edges of the image in to focus on -
the issue.

There are many websites that have information about Microsoft Office applications.
These usually contain frequently asked questions (FAQs) and give solutions to common
problems.
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https://support.microsoft.com/en-us/

This is Microsoft's main site for finding help to solve problems for all Microsoft

products. You can ask questions online and download files, including service packs,

drivers and patches.

https://support.microsoft.com/en-gb/powerpoint?ui=en-US&rs=en-GB&ad=GB

This site provides resources for all Microsoft Office applications, including
PowerPoint.

Another resource you can refer to is training material. Training courses on the use of a

presentation application usually provide a comprehensive set of instructions or notes

that are worth keeping for future reference.

You may have been to a training course to learn a particular computer function or you

may have received training or induction materials when you started a new job.

Help for overcoming issues

Mohana works as a personal assistant to a manager in a large organisation. One of
her roles is to produce PowerPoint presentations based on content and information
provided to her by her manager. Mohana often refers to the help functions to assist
her in making the most of the software and as a way of increasing her skills. If she
doesn't know what an icon does, she hovers over the icon with her mouse and reads
the bubble displayed.

Sometimes Mohana uses Microsoft's support website to find solutions to software
problems that cannot be solved using the help function. A colleague gave her some
instructions acquired during a training session. Mohana keeps these in a help folder
on her desktop.

A couple of times she has not been able to find the information herself, and has
needed to ask her colleague Lauren for help. Lauren is always happy offer advice and

suggest new ideas for enhancing the presentation.

-

\

)
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Practice Task 12

Question 1

Mohana has forgotten how to apply transitions to slides using PowerPoint. Which of the
following are ways for her to get help? Tick all that apply.

O

OHONORG)

Type in 'transitions’ into the search function.

Hover over ‘Transitions' on the ribbon at the top of the screen.
Do a search on the internet for ‘transitions in PowerPoint’,
Ask for help from an experienced colleague.

Use another effect rather than ‘transitions’.

Summary

A style guide outlines an organisation’s preferred style, such as the appearance of
text in documents.

It is important the audience is not distracted by unnecessary features in a
presentation; it can distract your audience from the content.

An interesting presentation will include visually attractive features to add impact
and emphasis to the content, such as graphics, sound and transition options.
You can streamline and customise your presentation to meet the needs of
different audiences with basic and hyperlinked custom shows.

Make sure you are familiar with how to access help and assistance if you
encounter problems to avoid delays in preparing your presentation by the

due date.
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Learning Checkpoint 2
Create presentations

Read the case study, then answer the questions that follow.

Case study

Claire was told to prepare an electronic presentation to show to external clients. She knew that
the clients wanted information about new legislation and how it was affecting the organisation.
She found lots of legislative documents and used the details to fill the slides that made up the
presentation.

Claire found a PowerPoint document on the company's database dated from the previous year that
had a similar title. She deleted the existing information and then updated the document with the
information she was given. Claire noticed this was an older version of PowerPoint and she wasted
a lot of time trying to find the functions because she was unfamiliar with this older version. Claire
then produced speaker notes that contained additional information.

Claire was under pressure trying to complete the presentation in time for the session with clients.
She was planning to do a trial run and practise the presentation in the hours leading up the
meeting. However, there were problems getting an internet connection for the hyperlinks. In the
end, she didn't get these to work and decided to include the information in the slides rather than
linking to the websites.

When Claire delivered her presentation, the audience did not seem to be engaged.

After the presentation, her manager told her that the audience wanted a general outline of the
legislation and there was too much detail in the information she presented. Her manager pointed
out that she used the old version of the company's logo and corporate colours.

1. Outline three things Claire could have done to avoid the issues listed above.
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2. Which of the following could Claire have added to her presentation to make it more interesting
to her audience? Tick all that apply.

O Apply transitions so the slides come in from the left to the right.

O Add her favourite music to improve the atmosphere of the room.

O Add some graphics such as high-resolution images to add visual impact.
O Add an animation to a couple of slides.

O Use a slide master to add consistency to the slideshow.

3. List two reasons why Claire should have used a style guide new template for her presentation?

4. List two features Claire would find if she had used the style guide.
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5. How could a custom slide show have been useful to Claire? Explain your answer.

6. Suggest at least two places Claire could have located help when using the older version of
PowerPoint?

7. Which of the following are ways Claire could check the readability of her presentation? Tick all
that apply.

Ask the audience if the font was the right size.

Consider the font size when the slides were projected onto a screen or viewed
online.

Break up the content with an interesting slide, such as an image or photograph.

Avoid using too many animations and sounds.

OO0 OO0

Use a dark colour for the text and background colours in the slides.
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3A Proofread your presentation
3B Finalise and print your presentation
3C Store your presentation
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3 A Proofread your presentation

Your presentation needs to be checked for spelling, grammar, consistency
and style.

Although you might write the text in your presentation very carefully, there will probably
still be some mistakes. It is better to find these during a rehearsal than in front of an
audience. You can edit and proofread your work by closely reading it yourself before
getting someone else to read it.

Editing involves checking that slides and any notes meet the requirements of the style
guide, and to identify and correct errors in grammar, punctuation and spelling.

If you have your own ideas on how the content or format could be improved, discuss
these with your supervisor.

Spelling I

Never rely entirely on the spell-check function on your computer. It only
identifies spelling errors, not words that have been used incorrectly. Words
may also be spelled in different ways; for example, American and Australian
spellings of words such as organize/organise. Check your organisation’s style
manual or ask your manager if you are unsure.

)

Grammar

Grammar and punctuation suggestions made by software applications are not
always correct. Check them yourself before accepting the suggested change.

Style

Style should be consistent throughout the document. Make sure headers and
footers are correct, and that the font is consistent throughout. Check your
organisation’s style manual or ask your supervisor if you are unsure.
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Numerical data

If you are working with numbers, match your document with the original figures
you were given and make sure they are accurate. It is easy to make a mistake
when entering a lot of numerical data into a document.

Spelling and grammar check

PowerPoint is equipped with an internal dictionary that can help you correct
words that are misspelled in your presentation.

As well as checking spelling, PowerPoint can also check style to make sure that each
slide is consistent. Check with a colleague or supervisor to determine the requirements of
your organisation. Then, make the necessary alterations to the style of your presentation.

To check the spelling and grammar of your presentation, open your presentation and
select the Review tab from the ribbon. Click on the ABC Spelling icon at the top left of
the screen.

When a word is misspelled or mistyped, a wavy red line appears under it to alert you to
the mistake.

To correct a misspelled word, right-click a word that has a wavy

iquant
red underline. If the word appears in the drop-down list, click :i\:::
the word that you want to replace the misspelled or mistyped e
word with. aliquots
If a red wavy line appears underneath a word that has been spelt chue
correctly, it is not in the built-in dictionary. To add it to the built- Ignore All
in dictionary, right-click the word and select Add to Dictionary. Add to Dictionary

To turn the automatic spelling and grammar check on or off, go to the File tab and click
Options. Click Proofing. Under When correcting spelling in PowerPoint, tick the
checkbox next to Hide spelling and grammar errors, then click OK.
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| PowerPont Options 7 x
ermers
Change how PowerPoint corrects and formats your tex
| Proofing
R £ J
e Astoloarect options
AuteCorrect Optiom.
When corrocting spefling in Microsolt Office programs
Sustom Dictionanes.
I v sped
Tuteo verd) formm only
When correcting spelfing sod grammar In PowerPoint
Recheck Dacumant

The AutoCorrect function in PowerPoint 2019 is a default setting of common
misspellings and symbols, which you can modify.

This feature corrects typos and misspelled words, and inserts symbols and other pieces
of text. Text included in hyperlinks is not automatically corrected.

The AutoCorrect feature also includes a series of parallel lists, where a particular word
typed can be automatically replaced by another word.

For example, the AutoCorrect feature can be used to:
« automatically correct typing errors and misspelled words; for example, if you type
‘teh’ instead of ‘the’
« insert symbols; for example, you can type :-) to insert a smiley emoji.

To adjust AutoCorrect settings, go to the File tab and select Options. Click on the
Proofing tab and select AutoCorrect Options. Here you can add, delete and amend

AutoCorrect options.

To add an entry to the list of automatic corrections, select the AutoCorrect tab. In the
Replace box, type a word or phrase that you often mistype or misspell (e.g. ‘usualy’). In
the With box, type the correct spelling of the word (e.g. ‘usually’). Click Add.
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AutoCorrect: English (United States) L\\, ?
AutoCorrect  AutoFormat As You Type Actions Math AutoCorrect

[ show AutoCorrect Options buttons

[V correct TWo INitial CApitals =
[ capitalize first letter of sentences
Capitalize first [etter of table cells

E] Capitalize names of days

Correct accidental use of cAPS LOCK key
Replace text as you type

Replace: With:

usualyl| "usually

untilll until
useing using

veyr very v

unpleasently unpleasantly A

Replace | Delete |

EI Automatically use suggestions from the spelling checker

I OK I Cancel

L. gigpfibns... \

Practice Task 13

Look at the following slide, then complete the tasks that follow.

Soar Throats

Coursed by:
= contagius Virusess,

« Infraction in tonsilis

« Bactaria such As strepp throat
« Alegory from polan or cats and dog’s

Question 1

Proofread the slide above and rewrite the information. Be sure to edit the spelling, punctuation,

grammar and other elements that affect the style consistency.

Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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Question 2

List two reasons why you shouldn’t rely on spell check to identify spelling mistakes in your
presentation?

68 Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting
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3 B Finalise and print your presentation

Hard copies are useful for the audience to refer to.

You can print handouts, notes or outlines. You need to decide on the appropriate
materials for each presentation and have the printed copies available within the
designated timeline. The type of handouts or notes you require will depend on the

presenter and the audience. For example, do you need hard copies of the slides with space
for the audience to write their notes or can a soft copy be emailed after the presentation?

Do your final corrections and alterations before printing; you don't want to find mistakes

after you have printed your document.

Creating handouts

Handouts can be customised to suit specific =~
requirements to make them consistent. Just

as the Slide Master is used to make the

style of your slides consistent, the Handout
Master is used to add information to your
handouts. This will then be reproduced on all

of the handouts in your presentation.

Keep in mind that the information you add
using the Handout Master will only appear
on your handouts, not on your slides.

Go to the View tab and select Handout
Master. You will see a template displaying
blank outlines of your slides.

In the handout template area there are four
editable regions (on the four corners of the
page). These include:

« header area

. footer area

« date area

« slide number area.

Click on the header area. The placeholders will be displayed.

To see more clearly, use the zoom function in the bottom right-hand toolbar to

zoom in. [ EEIE G et

29/01/2011
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Enter a suitable header for your presentation. Enter information in the Date, Footer and
Number areas.

The information you have entered on the Handout Master will appear on all handouts
you print for your presentation.

Save and close your presentation.

Printing handouts

You can also choose how many slides you would like on each handout. Consider the
readability and function of the handouts. For example, if you print the maximum number
of slides per page, there will be little room for notes. The readability of the information
may also be affected as the font may be too small to be legible.

To print out an exact replica of your presentation slides, select the File tab and click on
the Print tab. Click on the second drop-down menu under Settings to choose a handout
layout option to print.

For example, the 3 Slides option under Handouts provides three slides on each page
with lines for the audience to take notes.

Pt Pyweaaes | warrboor

- b - | :'
! !
| |

To specify the page orientation, select the fifth drop-down menu under Settings. Here
you can choose either Portrait Orientation or Landscape Orientation.

If you want to print handouts in colour, select a colour printer from the drop-down menu
under Printer. Then select the last drop-down menu under Settings and click Color.
Select Print to print the handout notes.
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Speaker notes

Speaker notes are designed to help the presenter outline any additional points or
information they would like to discuss, which may not be included in the slides.

If you add speaker notes to your PowerPoint presentation, you will be able to deliver the
presentation smoothly, without worrying about forgetting the main points. By selecting
Notes Master in the View tab, you can add header and footer information to your notes
as you did with the Handout Master.

To add notes to individual slides, open your presentation in Normal view. Decide which
slides you would like to add notes to. In the View tab, select Notes Page.

Click the text placeholder and begin typing your speaker notes at the bottom of
each slide.

Clck o add tnt

Speaker notes

To see how your notes pages will be printed and the full effect of any text formatting,
such as font colours, select the View tab and switch to Notes Page view. Here, you can
also check and change the headers and footers of your notes.

Each notes page shows an image of a slide, along with the notes that go with that slide.
In Notes Page view, you can add to your notes using charts, pictures, tables and other
illustrations.
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To print speaker notes for your presentation, select the File tab, then select the Print tab.
Select the second drop-down menu under Settings, and click Notes Pages. Again, you
can change the orientation to either portrait or landscape, then click Print to print the
speaker notes.

Printing an outline

If you choose to print an outline, this is the information that will be printed. Outlines
help you to view the whole presentation and make decisions about where you have placed
information. For example, you may decide to add new information or rearrange the old
information.

To print an outline of your presentation, click the File tab and select Print. Select the
second drop-down menu under Settings and select Outline, then click Print.

Practice Task 14

Question 1

Give two examples of how printed handouts are helpful for the audience in a face-to-face
presentation?
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Question 2

Suggest two ways printed speaker notes be used in a presentation?
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3 C Store your presentation

How you store your presentation depends on the requirements of your
organisation and who needs to access the presentation.

If your presentation needs to be available to all your colleagues, you should store it in
an appropriate place on the organisation’s server. Your colleagues can then access the
presentation from their workstation, as long as they have the application installed on
their computers.

An important task when creating and editing presentations is to save your work.
Saving the presentation ensures that you can use it or edit it again when required. Each
organisation has its own policies regarding naming and storing electronic documents,
and it is important that you follow these procedures so that you and other staff can
access the documents as required.

Folder structures and naming standards

Folders are used to organise files so they are easier to locate.

Each organisation uses folder structures and naming standards to ensure that all files
are stored in the correct location. Folders have a treelike structure that branches from a
parent directory to sub-folders in a hierarchical structure.

If your organisation has a network, you may have shared directories and folders that
several staff have access to.

Advantages of shared directories and naming standards

Organised files are easy to find. For example, it is much easier to find one file in 10 than it is
to find one in 100.

If someone is unavailable, others can access the document and finish it if necessary.

Work is less likely to be duplicated, as staff can check if a document has already been
created.

It is easy to share documents between employees.
Files are secure because they are backed up on a regular basis.

« Virus scans are normally run on shared folders on a regular basis.
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SERVER (C Drive)
Group A
Group B
Group C
Procedures
; Personnel
Projects
Project A
Project B
Project C

Project C_timelines.docx

Project C_researchl.docx

In the example structure above, the server has three folders for three separate work

groups:
« Group A
+  Group B
« GroupC

Group C has three major folders:

« Personnel
« Procedures

« Projects

The Projects folder includes:

« Project A
« ProjectB
«  ProjectC

Project C has two documents (or files):

+  ProjectC_timelines.docx

+  ProjectC_researchl.docx

The file path for retrieving a document starts at the server and ends when the correct
document is located. For example, to reach ProjectC_timelines.docx, the file path to
follow is:

C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx
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Manage shared directories

When you have access to a shared directory to store your files, you may also
have access to files created by other employees.

It is important that you check your files and delete any that are no longer required on
aregular basis to ensure the system remains efficient. Before deleting any files, check
which projects or clients you need to keep files for by asking your supervisor. You should
never delete or move files created by another employee without their permission; always
check first.

Organisations usually perform regular backups of shared directories and folders. In larger
organisations, a staff member from the IT department will usually be responsible for this.

Hard-copy storage

Many documents stored digitally may also be stored in hard copy.

Managing the storage of hard-copy documents requires you to conserve space and
dispose of irrelevant documents. It is normal office practice for staff to perform archiving
duties; that is, removing inactive files and placing them in long-term storage.

Here is an example of a retention schedule that may include documents saved in a
presentation format.

Retention schedules for hard-copy documents

Credit card receipts and statements 2 years
Tax records 6 years
Invoices 1year
Client correspondence 2 years
Presentations 6 months

Exit the application

After creating or modifying an electronic document, you need to exit the
software application without causing damage or loss of data.

Data loss can occur when a computer program stops performing its expected function.
Often the program, or even the whole computer, may appear to freeze. Data may be
accidentally erased or corrupted and made inaccessible.
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Before shutting down your computer, exit all programs by selecting the exit button,
which is generally located in the top right corner of the window. Ensure you save your
work first. If you have recently made changes to your presentation, you will usually be
prompted to save before exiting.

Here are some other procedures that help secure your work and prevent loss of information:

«  Work on a limited number of documents at one time.

«  Save the work regularly or have the auto save button turned on.

«  Exit the applications before leaving the workstation for any long period of time
and shut down the computer at the end of the day.

« Ensure your computer has anti-virus software that is frequently updated to
prevent data loss.

Passwords and security

Passwords may be required to ensure that only authorised users are able to
access certain files and information.

Access to an organisation’s data can be controlled at a number of levels, including drives
and files. Employees can be given access to shared directories or individual files.

Most organisations have networks made up of multiple computers. Before employees can
use a computer that is connected to the network, they must be issued a login username
and password, which identifies them and allows them to access the files on the network.
Below are the instructions for selecting a password and keeping your work secure. Your
IT support person can provide advice. Alternatively, refer to the organisational policies
and procedures for password protection.

Selecting a good password

You should change your password on a regular basis and ensure you do not tell
anyone what it is. Your password should not be anything that can be easily guessed
by other people, such as your date of birth, name, family members' names, etc.
Good passwords contain a mixture of letters and numbers and are least six to eight
characters long.

Protecting individual files

Depending on the network configuration, employees will have their own drive for
their files along with access to various shared drives. Where files contain sensitive
information that should not be accessed by all employees, you can apply a password
to an individual file. Two levels of access can be applied:

a password to open the file, which allows the file to be viewed and printed

a password to modify the file, which will let the user make changes to the file.
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Practice Task 15

Question 1

In the following exercise, you are required to password-protect your presentation.
1. In your presentation, go to the File tab. Info is selected by default.

2. Click Protect Presentation and select Encrypt with Password from the drop-down menu.

Protect Presentation

} Control what types of changes people can make to this presentation.
Protect
Presentation ~

3. Inthe Password box, type a password and click OK. In the Confirm password field,

re-enter the password and click OK.

LI YyUU TUT UT TUITYCTL LINIT pa>>wuil
be recovered. It is advisable to keeg
rds and their corresponding docun
n a safe place.

Iber that passwords are case-sensiti

OK

Protect Presentation will now be highlighted in a yellow cell.

Protect Presentation
o\

E_Q A password is required to open this presentation.
Protect
Presentation v

4, Save and close your presentation.

5. Reopen your document using your new password. Close your document.

Password ? X

Enter password to open file
Presentation1.pptx

Password: ||
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Summary

« A presentation must be proofread for spelling, grammar, consistency and style.

« Print presentation materials to suit the needs of the audience and the presenter.
If you are printing materials for someone else, make sure you discuss what they
need before printing.

+  You can print out handouts, notes and outlines of your presentation.

+ Your organisation will have a folder structure and naming standards to ensure
that all files can be accessed when required.

«  Follow the procedures for exiting the software application to prevent damage or
loss of data.
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Learning Checkpoint 3
Finalise presentations

Part A

Read the case study, then answer the questions that follow.

Case study

John works for a small not-for-profit organisation. Part of his job is to create a monthly presentation
to send out via email to the organisation’s clients. John always has a short deadline in which to get
the presentation prepared because he is often held up waiting for contributions from others in the

organisation.

John thinks the presentation looks outdated and has decided that he will change the font type,
add some bright images, include animations and add the logo in the footer. John wants to show
his supervisor that he is skilled, so he doesn't ask his supervisor to review the presentation as he
normally would before sending it out to clients.

1. Which of the following statements relate to John's finalising his presentation? Tick all that apply.

O John is a good speller and can proofread his own work.

O John should be following the task requirements given to him by his supervisor.
O John should be following the style guide used by the organisation.

O John's boss will be pleased that he has shown initiative and used his skills.

O John should only make changes approved by his supervisor.

2. Give two examples of ways John could make sure the presentation is accurate and error-free.
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Part B

Read the case study, then answer the questions that follow.

Case study

Jonah has spent an afternoon working on a presentation that is due to be sent out the following
day. While he was working on the presentation, he kept other documents open in the background,
including four other presentations.

Jonah leaves his desk to make a cup of tea, and when he returns, he finds the screen has frozen
and he cannot get any functions to work. After waiting for some time, he gains control and checks
his presentation, only to find he has lost half of the presentation and only the first five slides remain.

1. What steps could Jonah have taken to avoid losing his work?

2. Jonah becomes ill that afternoon. He saves his work and goes home early without finishing the
presentation. Give two reasons why it was a good idea for Jonah to save his work using the
naming and filing procedures he has been taught to use.
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